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ВВЕДЕНИЕ 
 
 

В ходе изучения дисциплины «Введение в технологии компьютер-
ного моделирования» студенты получают навыки компьютерного мо-
делирования физических процессов с использованием современных 
программных средств. 

В настоящее время широко применяются компьютерные модели 
для анализа сложных систем в процессе проектирования современных 
изделий и технологий. Однако для реализации таких моделей, исполь-
зующих численные методы, например, метод конечных элементов, тре-
буется значительное количество времени на вычисления. Одним из 
способов сокращения времени моделирования является использование 
суррогатных моделей, которые также известны как метамодели. Эти 
модели могут заменить вычислительно затратные конечно-элементные 
модели. Одним из современных программных средств для реализации 
технологии метамоделирования является модуль Design Exploration 
программного комплекса Ansys. 

Приобретение навыков работы с данным программным продуктом 
осуществляется посредством выполнения студентами лабораторных 
работ. Практическое пособие содержит пример реализации задачи оп-
тимизации в Ansys DesignXplorer.  

Пособие может быть использовано при выполнении лабораторных 
работ, а также оно позволит получить навыки работы в Ansys 
DesignXplorer при самостоятельном изучении. 
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ЗАДАЧА 1  
ПРОВЕДЕНИЕ ПАРАМЕТРИЧЕСКОГО 

ИССЛЕДОВАНИЯ «ЧТО, ЕСЛИ?»  
В ANSYS WORKBENCH 

 
 
1.1 Постановка задачи  
 
Данный пример позволяет познакомиться с возможностями пакета 

Ansys Workbench для проведения параметрического исследования «Что, 
если?» Исследование «Что, если?» выполняется по списку заданных 
вручную расчётных точек. Для проведения таких исследований модуль 
DesignXplorer не нужен. При этом исследование «Что, если?» позволяет 
получить предварительную информацию, которую затем можно исполь-
зовать в модуле DesignXplorer для проведения дальнейших исследований. 

Прицепное устройство, созданное в ANSYS DesignModeler, состоит 
из трех частей (рисунок 1). На рисунке 1 также показаны нагрузки и 
ограничения, приложенные к прицепному устройству. 

 

 
  

Рисунок 1 – Прицепное устройство 
 
На рисунке 2 показаны геометрические размеры прицепного 

устройства, которые при выполнении работы будут использованы в ка-



6 

 

честве входных параметров. При этом значения массы прицепного 
устройства, напряжений и деформаций, формируемых при приложении 
нагрузки, будут использоваться в качестве выходных параметров.  

 

 
 

Рисунок 2 – Геометрические параметры прицепного устройства, 
 используемые в качестве входных параметров модели 

 
 

1.2 Реализация задачи при помощи графического 
интерфейса Ansys Workbench 

 
1. Решение задачи начинается с запуска Ansys Workbench, который 

выполняется из основного меню Пуск → Программы → Ansys 2020R1 → 
Workbench 2020R1.  

2. Выбираем File → Open. Затем в появившемся окне выбираем 
файл с именем receiver.wbpz. Сохраняем проект с именем receiver и 
расширением wbpj. В результате в окне Project Schematic появится ана-
литический блок, который будем использовать в качестве заготовки для 
нашей модели ( рисунок 3). 

3. Дважды нажимаем на ячейку Geometry. В открывшемся окне 
DesignModeler появится модель прицепного устройства. В окне Tree 
Outline выбираем Gusset. Далее в Details View устанавливаем флажок на 
FD1, Depth, чтобы сделать его входным параметром. После этого по-
явится диалоговое окно для указания имени параметра. Укажите имя 
thick_ds ( рисунок 4). 

4. В окне Tree Outline выбираем YZPlane. В YZPlane выбираем 
Sketch4, в разделе Dimensions, как и в пункте 3, устанавливаем флажки 
на H6 (name – horiz_ds) и V7 (name – vert_ds) ( рисунки 5,6 ). Закрываем 
DesignModeler. 
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Рисунок 3 – Результаты импорта модели 
 

 
Рисунок 4 – Задание параметра thick_ds 
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Рисунок 5 – Задание параметра horiz_ds 

 

 
Рисунок 6 – Задание параметра vert_ds 



9 

 

5. Схема проекта (Project Schematics) теперь включает панель па-
раметров (Parameter Set). Стрелка, выходящая из Parameter Set и соеди-
няющаяся с ячейкой Parameters в Static Structural, указывает, что опре-
делены входные параметры (рисунок 7). Дважды нажимаем на ячейку 
Parameters и открываем соответствующее окно, в котором видны задан-
ные входные параметры проекта (рисунок 8). 

 

 
 

Рисунок 7 – Схема проекта с панелью параметров 
 

 
Рисунок 8 – Входные параметры проекта 
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6. Дважды нажимаем на Setup (Project Schematic) (рисунок 7). В за-
висимости от версии ANSYS может появиться или не появиться диало-
говое окно, указывающее, что вышестоящие данные должны быть про-
читаны повторно. Если данное окно появилось, то нажимаем Yes для 
открытия окна Mechanical. Если окно для подтверждения не появилось, 
то окно Mechanical открывается автоматически (рисунок 9). 
 

 
Рисунок 9 – Графический интерфейс Workbench Mechanical 

 
7. Далее в окне Outline графического интерфейса Workbench 

Mechanical выберем пункт Model → Geometry из древовидной структу-
ры расчетной модели. В окне Details of “Geometry” во вкладке Properties 
ставим флажок на ячейку Mass (рисунок 10). 

8. В окне Outline находим Solution (A6) и выбираем Equivalent 
Stress. Далее в разделе Details под ячейкой Results ставим флажок на 
Maximum, чтобы определить выходным параметром максимальное эк-
вивалентное напряжение (рисунок 11). 

9. В том же разделе Solution выбираем Total Deformation и также 
ставим флажок на ячейку Maximum, чтобы определить выходным па-
раметром максимальные деформации (рисунок 12). 
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Рисунок 10 – Определение массы в качестве выходного параметра 
 

 
 

Рисунок 11 – Определение максимальных эквивалентных напряжений  
в качестве выходного параметра 
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Рисунок 12 – Определение максимальных деформаций  
в качестве выходного параметра 

 
10. Выходим из Mechanical и в Project Schematic обновляем проект 

(Update Project). Дважды нажимаем на ячейку Parameters и открываем 
соответствующее окно, в котором видны заданные входные и выходные 
параметры проекта и сгенерированная точка проекта (рисунки 13,14). 

 

 
 

Рисунок 13 – Входные и выходные параметры проекта 
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Рисунок 14 – Сгенерированная точка проекта 
 

11. Добавляем еще 3 точки (ПКМ → Duplicate Design Point)  
(рисунок 15). 

 

 
Рисунок 15 – Добавление 3 точек проекта 

 
12. На панели инструментов нажимаем Update All Design Points. 

Когда обновление закончится, в таблице появятся результаты расчетов 
(рисунок 16). 

 

 
 

Рисунок 16 – Результаты расчетов 
 

13. Добавим диаграмму, которая отображает отношения между 
выбранным параметром и каждой точкой проекта. Если вы не видите на 
экране панель диаграммы Chart в нижнем правом углу рабочего окна, 
то надо выбрать View → Chart. На панели Outline под Output Parameters, 
выбираем P7 – Total Deformation (может быть другой номер). В данный 
момент ниже в разделе Charts нет никаких диаграмм. 

14. Если Toolbox не открыта в рабочем окне, то выбираем View → 
Toolbox и открываем его.  
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В Toolbox дважды нажимаем на Design Points vs P7, чтобы доба-
вить соответствующую диаграмму. 

15. В окне Outline под Charts выбираем Parameter Chart 0. На пане-
ли свойств Properties X-Axis (Bottom) устанавливаем Design Points           
и Y-Axis (Left), выбираем P7 – Total Deformation Maximum (рисунок 17). 

 

 
Рисунок 17 – Настройка параметров диаграммы 

 
Панель Graph теперь будет отображать диаграмму. Точки проекта 

расположены по оси X в нижней части диаграммы, а значение макси-
мальных деформаций отображается по оси Y в левой части диаграммы 
(рисунок 18). 

 

 
Рисунок 18 – Отображение панели Graph 

 
Выбрав дополнительно на панели свойств Properties Y-Axis (Right) 

P4 – Geometry Mass, отобразим значения массы детали по оси Y в пра-
вой части диаграммы (рисунок 19). 
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Рисунок 19 – Отображение панели Graph 

 
16. Добавим диаграмму Parameters Parallel Chart, которая показы-

вает отношения между всеми параметрами и каждой точкой проекта.    
В Toolbox дважды нажимаем на Parameter Parallel Chart, чтобы доба-
вить эту диаграмму. Далее в Outline таблице под Charts выбираем Pa-
rameter Parallel Chart 0. В результате появится соответствующая диа-
грамма в окне справа внизу. Значения вверху и внизу показывают раз-
брос, относящийся к каждому параметру. Каждая цветная линия на диа-
грамме отражает соответствующую точку проекта (рисунок 20). 

 
Рисунок 20 – Отображение панели Parameters Parallel Chart 

 
17. Решение генерируется для проектной точки, обозначенной как 

Current на панели Table. Если, основываясь на изучении проекта, вы ре-
шите, что предпочтительнее использовать другую точку проектирования, 
вы можете определить ее как текущую точку проектирования. В Table of 
Design Points нажимаем ПКМ на DP 2 (если вы считаете проектную точ-
ку 2 предпочтительной) и выбираем Copy inputs to Current (рисунок 21). 
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Рисунок 21 – Определение новой текущей точки проекта 
 

Затем нажимаем ПКМ на DP 0 и выбираем Update Selected Design 
Points. Когда обновление закончится, результаты для DP 0 теперь сов-
падают с DP 1 в таблице (рисунок 22).  

 

 
 

Рисунок 22 – Обновление текущей точки проекта 

 
18. Запускается Mechanical. В древе проекта Outline → Environment 

(A5) → Solution выбираем Equivalent Stress и получаем решение для 
выбранной текущей точки проекта (рисунок 23). 
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Рисунок 23 – Эквивалентные напряжения для текущей точки проекта 
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ЗАДАЧА 2  
ПРОВЕДЕНИЕ ОПТИМИЗАЦИИ   

В ANSYS DESIGNXPLORER 
 
 
2.1 Введение  
 
Явные аналитические зависимости характеристик объекта от пара-

метров проектирования сложно получить для реальных объектов модели-
рования. В подобных случаях компьютерное моделирование применяется 
для сокращения количества дорогостоящих экспериментов. При этом ис-
пользование сложных моделей для конечно-элементного анализа делает 
время моделирования очень большим. Если выполнение одного экспери-
мента с моделью требует более часа, то проведение сотен экспериментов 
при решении задач оптимизации становится нецелесообразным. Решение 
данной проблемы целесообразно с применением суррогатного моделиро-
вания, в рамках которого математические предсказательные модели для 
сложных систем строятся по результатам вычислительных экспериментов 
с компьютерными моделями. Формирование таких моделей основано на 
идеях машинного обучения, где модели «обучаются» на множестве вход-
ных и выходных данных – результатах экспериментов. Построенные сур-
рогатные модели заменяют собой источники получения данных. Как пра-
вило, такие модели имеют существенно более высокую вычислительную 
эффективность по сравнению с исходными моделями. Таким образом, 
цель построения суррогатных моделей – предоставление приближенных 
значений выходных параметров на основе входных параметров без про-
ведения полных расчётов. Достижение данной цели обеспечивается в ре-
зультате применения метода планирования вычислительных эксперимен-
тов. Другой целью суррогатного моделирования является использование 
созданных моделей при оптимизации параметров конструкций и техноло-
гических процессов.  

В программной среде Ansys Workbench оптимизация моделей про-
водится в модуле DesignXplorer. DesignXplorer использует входные и 
выходные параметры, которыми могут служить параметры 
DesignModeler или из различных систем автоматизированного проекти-
рования. Входными параметрами могут быть значения толщины, дли-
ны, механические нагрузки, свойства материалов и т. д. Выходными 
параметрами, как правило, выступают масса, напряжение и др.  
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После настройки входных и выходных параметров могут быть за-
пущены следующие виды анализов в DesignXplorer:  

– планирование эксперимента (Design of Experiments – DOE);  
– поверхность отклика (Response Surface);  
– оптимизация. 
Планирование эксперимента является основой DesignXplorer. Тех-

ника планирования эксперимента позволяет определить количество за-
пусков расчетной задачи с учетом получения максимально точной по-
верхности отклика насколько это возможно. Каждая комбинация пара-
метров, которая решается, именуется Design Point (точка конструирова-
ния или проектирования).  

После того, как планирование эксперимента выполнено, создается 
поверхность отклика на основе рассчитанных результатов. Поверхность 
отклика создается для каждого выходного параметра. Исходными дан-
ными для построения поверхности отклика служат численные данные, 
представленные в таблице результатов Design Point. В общем случае 
поверхность отклика помогает провести анализ результатов расчета.  

Для того, чтобы обеспечить прочностные показатели детали               
с меньшей массой или габаритами, в частности, необходимо использо-
вать модуль оптимизации. Этот модуль позволит подобрать нужные 
входные параметры с учетом заданных пользователем ограничений на 
выходные параметры. Например, задав показатель массы и уровень 
напряжений, программа подберет значения каких-либо размеров детали. 

 
 
2.2 Постановка задачи  
 
Целью проведения оптимизационного исследования является мини-

мизация массы детали с сохранением безопасного уровня напряжений. 
Входными параметрами выступают геометрические размеры детали.  

Как и в работе «Проведение параметрического исследования “Что, 
если?” в Ansys Workbench», в данной работе используется прицепное 
устройство, созданное в ANSYS DesignModeler (рисунок 1). На ри-
сунке 1 представлены нагрузки и ограничения, приложенные к прицеп-
ному устройству. 

При выполнении работы будут использованы в качестве входных 
параметров геометрические размеры прицепного устройства, представ-
ленные на рисунках 2, 24.   
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Рисунок 24 – Геометрический параметр H7 (толщина квадратной трубы),  
используемый в качестве входного параметра модели 

 
2.3 Реализация задачи при помощи графического 

интерфейса Ansys Workbench 
 
1. Решение задачи начинается с запуска Ansys Workbench, который 

выполняется из основного меню Пуск → Программы → Ansys 2020R1 → 
Workbench 2020R1.  

2. Выбираем File → Open. Затем в появившемся окне выбираем 
файл с именем receiver.wbpz. Сохраняем проект с именем receiver и 
расширением wbpj. В результате в окне Project Schematic появится ана-
литический блок, который  будем использовать в качестве заготовки 
для нашей модели (рисунок 3). 

3. Дважды нажимаем на ячейку Geometry. В открывшемся окне 
DesignModeler появится модель прицепного устройства. В окне Tree 
Outline выбираем Gusset. Далее в Details View устанавливаем флажок   
на FD1, Depth, чтобы сделать его входным параметром. После этого по-
явится диалоговое окно для указания имени параметра. Укажите имя 
thick_ds (рисунок 4). 
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4. В окне Tree Outline выбираем YZPlane. В YZPlane выбираем 
Sketch4, в разделе Dimensions, как и в пункте 3, устанавливаем флажки 
на H6 (name – horiz_ds) и V7 (name – vert_ds) (рисунки 5, 6).  

5. В окне Tree Outline выбираем Plane4. В Plane4 выбираем Sketch2, 
в разделе Dimensions, как и в пунктах 2–3, устанавливаем флажок на H7 
(name – horiz_ds) и V7 (name – thick_tube) (рисунок 25). Закрываем 
DesignModeler.  

 

 
Рисунок 25 – Задание параметра thick_tube 

 
6. Дважды нажимаем на ячейку Parameters и открываем соответ-

ствующее окно, в котором видны заданные входные параметры проекта 
(рисунок 26). 

7. Дважды нажимаем на Setup (Project Schematic) и открываем окно 
Mechanical (рисунок 9). 

8. Далее в окне Outline графического интерфейса Workbench 
Mechanical выберем пункт Model → Geometry из древовидной структу-
ры расчетной модели. В окне Details of “Geometry” во вкладке Properties 
ставим флажок на ячейку Mass (рисунок 10). 
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Рисунок 26 – Входные параметры проекта 

 
9. В окне Outline находим Solution (A6) и выбираем Equivalent 

Stress. Далее в разделе Details под ячейкой Results ставим флажок на 
Maximum, чтобы определить максимальное эквивалентное напряжение 
выходным параметром (рисунок 11). 

10. Выходим из Mechanical и в Project Schematic обновляем проект 
(Update Project). Дважды нажимаем на ячейку Parameters и открываем 
соответствующее окно, в котором видны заданные входные и выходные 
параметры проекта и сгенерированная точка проекта (рисунок 27). 

 

 
Рисунок 27 – Входные и выходные параметры проекта 
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11. В окне Toolbox → Design Exploration → дважды нажимаем на 
Response Surface и добавляем новую поверхность отклика к проекту 
(рисунок 28). 

 

 
 
 
 

Рисунок 28 – Добавление Response Surface в проект 
 
12. В появившемся новом блоке Response Surface дважды кликаем 

на Design of Experiments (ячейка с молнией). В открывшемся окне вы 
увидите ранее определенные входные и выходные параметры в таблице 
Outline (рисунок 29). 
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Рисунок 29 – Окно Design of Experiments 
 
13. Выбрав параметры P2 – horiz_ds, P3 – vert_ds, установите верх-

ние и нижние границы, равные 25 мм и 35 мм. Для параметра P8 – 
thick_tube установите границы, равные 1мм и 5 мм. Отключите пара-
метр P1 – thic_ds из моделирования, сняв соответствующую галочку 
(рисунок 30). 

14.  Далее выберите Design of Experiment и в Properties убедитесь, 
что Design of Experiment Type установлен на Central Composite Design, 
и выберите гранецентрированный вариант центрального композицион-
ного плана эксперимента (рисунок 31).  

В Ansys Workbench существует возможность выбора различных 
вариантов планирования эксперимента: латинский гиперкуб, цен-
тральный композиционный план и др. В свою очередь, каждый из этих 
типов имеет еще несколько настроек, ознакомиться более подробно с 
которыми можно из документации к программной среде. Кроме того, 
пользователь сам может вручную ввести матрицу планирования вход-
ных факторов, выбрав тип планирования Custom. 
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15. На панели инструментов нажмите Preview, чтобы посмотреть 
какие точки были сгенерированы в плане эксперимента. В таблице 
Table of Outline представлены пятнадцать точек (рисунок 32). Обновите 
Design of Experiments (Update). Когда обновление закончится, таблица 
будет заполнена результатами расчетов (рисунок 33). 

 

 
 

Рисунок 30 – Изменение диапазона входных параметров 
 

 
 

Рисунок 31 – Выбор плана эксперимента 
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Рисунок 32 – План численного эксперимента  

 

 
 

Рисунок 33 – Результаты расчетов  
 
16. Затем возвращаемся в окно Project Schematic. В блоке Response 

Surface нажмите дважды на ячейку Response Surface. Затем обновите 
все в открывшемся окне, выбрав в таблице Outline пункт Response 
Surface, задайте Full 2nd-Order Polynomial – стандартный алгоритм по-
строения метамодели в таблице Properties of Outline (рисунок 34). 

Для построения метамодели при использовании модуля ANSYS  
Design Exploration также доступны следующие алгоритмы: крикинг 
(Kriging); непараметрическая регрессия (Non-Parametric Regression; 
искусственная нейронная сеть (Neural Network) и др. 
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Рисунок 34 – Окно Response Surface 

 
17. На панели Outline в разделе Response Points мы видим, что была 

сгенерирована одна точка вместе с ее диаграммой (рисунок 34). Выбрав 
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диаграмму этой точки (Response), посмотрите автоматически сгенери-
рованный график. Изменяя соответствующие параметры, можно уви-
деть, как изменяются выходные параметры при изменении входных па-
раметров в трех вариантах просмотра: 2D, 3D и 2D Slices (рисунок 35). 

 

 
 

Рисунок 35 – Варианты просмотра поверхности отклика 
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18. При переходе на панели Outline к разделу Goodness Of Fit фор-
мируются данные, позволяющие судить о качестве метамодели (рису-
нок 36). На графике по оси абсцисс отложены значения конечно-
элементного моделирования, а по оси ординат – значения, полученные 
при помощи соответствующих регрессионных уравнений. Чем ближе 
полученные точки находятся к диагонали, тем выше точность модели. 

Для оценки полученных моделей также можно использовать кри-
терии, представленные на рисунке 35:  

– коэффициент детерминации 
 

2
2  = 1

2
 = 1

   
 

(  )= 1 ,
(  )

n
i i i
n
i i

d yR
d d

∑ −−
∑ −

 

 
– средняя квадратичная ошибка (англ. Root Mean Square Error, RMSE) 
 

2
 = 1  1 = (  ) ,n

i i iRMSE d yn∑ −  
 

где di – значения, определенные методом конечных элементов, 
 уi – значения, определенные с использованием регрессионных 

моделей. 
 

 
 

Рисунок 36 – Оценка качества метамодели 
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19. При переходе на панели Outline к разделу Local Sensitivity стро-
ится диаграмма, отображающая влияние входных параметров на вы-
ходные параметры (см. рисунок 37). 

 
Рисунок 37 – Диаграмма чувствительности оптимизируемых параметров 
 
20. В окне Toolbox → Design Exploration → дважды нажимаем на 

Response Surface Optimization и добавляем новый блок оптимизации к 
проекту (рисунок 38). 

21. В блоке Response Surface Optimization дважды щелкните ячейку 
Optimization, чтобы открыть ее (рисунок 39).  

22. На панели Outline выберите Optimization. Для проведения мно-
гокритериальной оптимизации на панели Properties задайте параметры 
оптимизации, как показано на рисунке 40, выбрав генетический алго-
ритм MOGA. 

Многокритериальная оптимизация – это одновременная оптимиза-
ция двух и более целевых функций. Одним из методов решения таких за-
дач является выявление совокупности оптимальных по Парето решений, 
которые не доминируют относительно друг друга, а улучшение одного 
параметра приводит к ухудшению других. Генетические алгоритмы яв-
ляются частным случаем эволюционных методов и обеспечивают поиск 
лучших решений при помощи наследования и усиления полезных свойств 
множества объектов в процессе имитации их эволюции. Одним из      
эффективных генетических алгоритмов является алгоритм MOGA      
(Multi-Objective Genetic Algorithm). 
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Рисунок 38 – Добавление Response Surface Optimization в проект 

 

 
Рисунок 39 – Окно Response Surface Optimization 
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Рисунок 40 – Выбор алгоритма оптимизации  

 
23. На панели Outline выберите Objectives and Constraints. В обла-

сти Table для параметров P9 – Geometry Mass и P10 – Equivalent Stress 
Maximum укажите цели, как показано на рисунке 41, и обновите ячейку 
Optimization. 
 

 
Рисунок 41 – Постановка оптимизационной задачи  
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24. Чтобы просмотреть точки-кандидаты, найденные в результате 
оптимизации, на панели Outline в разделе Results выберите Candidate 
Points (рисунок 42). 

 

 
Рисунок 42 – Результаты оптимизации  

 
25. Чтобы убедиться, что Candidate Point 1 является эффективным 

вариантом, щелкните его правой кнопкой мыши и выберите Verify by 
Design Point Update. Когда обновление будет завершено, на панели 
Table дополнительно появится Candidate Point 1 (verified) (рисунок 43). 

 

 
Рисунок 43 – Проверка результатов оптимизации  

 
26. На панели Outline в разделе Results выберите Candidate Points. 

Щелкните правой кнопкой мыши Candidate Point 1 и выберите Insert as 
Design Point (см. рисунок 44). Закройте ячейку Optimization.  

 

 
Рисунок 44 – Выбор Candidate Point 1 в качестве Design Point 

 
27. В основном окне проекта Project Schematic дважды щелкните     

Parameter Set. Затем на панели Table щелкните правой кнопкой мыши     
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DP 1 и выберите Copy inputs to Current (рисунок 45). Текущая точка про-
ектирования теперь имеет те же значения входных параметров, что и ваш 
лучший кандидат. Щелкните правой кнопкой мыши текущую точку про-
ектирования и выберите Update Selected Design Points (рисунок 46). 

 

 
 

Рисунок 45 – Выбор DP1 в качестве текущей точки проекта 

 

 
 

Рисунок 46 – Обновление расчетной точки 
 

28. Закройте окно Parameter Set. Дважды щелкните ячейку Solution, 
чтобы ее открыть (рисунок 47). 
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Рисунок 47 – Ячейка Results 

 
29. В Outline в окне выберите EquivalentStress, чтобы просмотреть 

результаты (рисунок 48). 
 

 
 

Рисунок 48 – Результаты расчетов 
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